DSC 6 Help

DSC 6 Description

The DSC 6 is a heat-flux differential scanning calorimeter. Heat flow is determined by measuring a
temperature difference over a very accurately known thermal resistance. The DSC 6 system permits the
direct calorimetric measurement, characterization, and analysis of thermal properties of materials. Under
the control of the Pyris Software for Windows on your PC, the DSC 6 is programmed from an initial to a
final temperature through transitions in the sample material such as melting, glass transitions, solid-state
transitions, or crystallization. Usually the DSC 6 is programmed to scan a temperature range at a linear
rate for the study of these endothermic and exothermic reactions. Endotherms and exotherms can be
shown as an upward or downward deviation from the baseline. The DSC 6 can also be used to perform
isothermal experiments,

The DSC 6 has an integrated cooling system which accepts various types of cold liquids or gas. This
allows operation of the DSC 6 from ambient to 450°C. It is recommended that normal tap water be used
as a cooling agent. The tap water must be circulated through the heat exchanger at a fow flow rate
between 5.52 and 8.90 kPa (8 - 10 cc/min) during the operation of the analyzer.

For subambient operation to —120°C, cold gaseous nitrogen is required. A controlled-pressure liquid
nitrogen dewar systern is necessary. This maintains a constant pressure level of 8.90 - 20.7 kPa {(1-3
psi).

For more discussion of the features of the DSC 6, click on one of the topics below:
@ Furnace and Sensor Design

@ Display l
@ Cooling
@

Modular Construction
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Furnace and Sensor Design

A low-mass furnace forms the heart of the DSC 8. The furnace is designed for ruggedness and
resistance to chemical corrosion. Because of its low mass, the furnace can heat and cool rapidly.

A platinum resistance sensing device measures and controls the furnace temperature. This device,
coupled with intrinsic “fuzzy logic” technology, provides very accurate furnace temperature controf with
minimal temperature overshoot. Fuzzy logic maintains tight temperature control because it incorporates
intelligent decision-making capabilities.

The atmosphere surrounding the sample is controlled very efficiently since the gas enters above the
sample crucible. This is extremely important when performing oxidative stability experiments. The purge
gas is also preheated resulting in minimal disturbance of the signal.

The sample is placed on a precisely machined sensor disk constructed of 90% nickel/10% chromium.
This rugged and durable disk provides high thermal conductivity and a very low time constant for superior
instrument response. Highly sensitive thermocouples measure the temperature at both the sample and
reference positions. The DSC 6 accommaodates the complete range of Perkin—EImer sample pans. Over

two dozen different pan types are available.
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DSC 6 Cooling

The DSC 6 incorporates a built-in cooling chamber that lies below and is attached to the furnace
assembly. The chamber uses a simple in/out design which allows for the use of any noncorrosive

circulating liquid or cooling gas. Cooling gases include liquid nitrogen and cooling fiquids include water
and ethylene glycol.

Cooling with fiquid nitrogen gas is simple, fast, and inexpensive. It requires only a transfer line and a
iow-pressure LN2 dewar — no extra accessories are needed. For cooling with liquids, many commercial
circulating coolers are available that can be interfaced to the DSC 6.
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Safety Precautions for the DSC 6

& WARNING: Be sure that all instrument operators read and understand the following
precautions. It is advisable io post a copy of these precautions on or near the instrument
itself,

The following precautions must be observed before and when using the DSC 6 Differential Scanning
Calorimeter:

@ Before connecting the DSC 6 to the mains outlet, check the mains voltage setting and fuse.
@ The DSC 6 requires a good earth ground that is common to the earth ground of the computer,

@ Do not operate the instrument in a cold room. The ambient temperature and the temperature of the
instrument should be between 10°C and 30°C.

WARNING: Never touch the outer and inner furnace lids. The temperature of the furnace
can reach as high as 450°C. Use tweezers 1o remove the lids.

WARNING: Do not touch the inside of the furnace; it might be hot and internal poliution
can cause loss of performance,

WARNING: Always ensure that there is adequate ventilation when operating the DSC 6.
Operate the DSC 6 in a fume hood when running samples that give off toxic gases since
the reaction gases escape through the furnace lids.

CAUTION: Do NOT expose the sensor surfaces to mechanical stress. If no external cooling is
applied, do not operate the DSC 6 above 50°C.

CAUTION: Do not exert excessive forces on the sensor digks,
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CAUTION: Care must be taken when handling the outer furnace kid so its ceramic lining is not
damaged.

&

Avoid contamination of the furnace, use high-purity purge gases to purge any reaction products out of
the furnace, and heat the furnace to temperatures above 430°C ONLY when absolutely necessary.

@

Check that the coofing liquid supply is circulating before starting a run.

&

Ensure the purge gases are set to the recommended flow rates. A rate that is too high will disturb the
inner furnace lid.

&

Never open the furnace when it is at an elevated temperature.
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Calibration of the DSC 6

The DSC 6 analyzer has been calibrated at the factory for both temperature and heat flow. Under normal
conditions, the DSC 6 does not need temperature recalibration. As a result of the use of high-precision
Pt100 sensors, the temperature accuracy does not vary over the temperature range and remains
constant for long periods of time.

We recommend that the temperature calibration and heat flow calibration be checked using the
precrimped samples of indium and zinc before obtaining data. We also recommend that you perform
calibrations in the following order:

@ Baseline Correction
@ Temperature Calibration
@ Heat Flow Calibration
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Baseline Correction of the DSC 6

Generally, it is not necessary to perform a baseline correction on the analyzer. However, if you find that
your baselines have too much slope (>3 mW at a scan of 20°C/min with no sample pans in the furnace),
you can perform a baseline correction. The baseline correction eliminates a static offset and drift of the
baseline during a temperature scan. The correction performed is a linear correction between two points.

To correct the baseline, perform the following steps:

i.

SR

10,

Determine the temperature range over which the baseline is to be optimized. It is not necessary to
optimize the baseline over the entire temperature range if most of your experiments will be performed
over a smaller portion of the range.

Select the coolant or cooling accessory that will be used for your experiment.

Set the purge gas to a flow rate of approximately 20 — 30 cc/min.

Remove all sample and reference pans from the furnace. Make sure that the furnace lids are In place.
in the Pyris software, click on the DSC 6 button in the Pyris Manager to select the DSC 6.

From the Method Editor, select File followed by Open Method. A list of method file names is
displayed.

Double click on baseline.d6m. This method is displayed on the screen. It can be used for obtaining
routine baselines. if necessary, change any of the values, e.g., the temperature program.

Make sure the Sample Weight box contains 0.00.

Click on the Start bution n the Control Panel to start the run. The light on the DSC 6
will change from red to green indicating that the DSC 6 is in temperature control and data are being
collected.

When the run is finished, save the data file by selecting Save in the File menu and entering a data file
name in the dialog box.

The data file from this run is used to correct the baseline of subsequent runs. The two-point baseline
correction is active over the whole temperature range used. To correct the baseline of a data file, you
would select Use Baseline Subtraction in the Initial State page (click here 1o see page). This activates the
other fields in the Baseline File box. From the Browse dialog box, select the file collected here.
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Temperature Calibration

The DSC 6 has been calibrated at the factory for temperature, Under normal conditions the DSC 6 does
not need temperature calibration. As a result of the use of high-precision Pt100 sensors, the temperature
accuracy does not vary over the temperature range and rernains constant for long periods of time.

It is recommended that a baseline correction be performed before temperature calibration.

At least two measured onset temperatures are necessary to calibrate the DSC 6. The calibration
materiais selected must have at least a 50°C temperature difference in their theoretical Onset
temperatures. Indium and zinc are the recommended calibration materials. However, other reference
materials can be used to calibrate the analyzer.

To calibrate temperature of the DSC 6:

1.

4.

While using the Instrument Viewer or the Method Editor in the Pyris software, select Calibrate from
the View menu. The Calibration window is displayed.

Restore the default temperature calibration by selecting Temperature from the Restore menu. if you

are going to perform a heat flow calibration, restore all defauit calibration values by selecting the All
command.

Select the Save and Apply button in the Calibration window to send the default values to the

analyzer and save the current cafibration file. The Save As dialog box appears. Select OK to save the
default file.

Select Close to close the Calibration window and begin using the new calibration values.

After you have done these steps, go on to the following topics to complete the temperature calibration of
the DSC 6:

@ Performing Indium and Zinc Runs

@ Performing a Peak Area with Onset Calculation

@ Performing a Temperature Calibration
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Performing a Peak Area with Onset Calculation

For the indium and zinc runs that you performed, a Peak Area with Onset calculation is performed. The
data file you just collected should be displayed in the Data Analysis window. Perform an onset calculation
oh the data as follows:

1. Select Onset from the Calc menu. The Onset Calculation dialog box appears.

2. Enter the Left Limit and the Right Limit. You can also click on the two red X’s that appear on the
curve and drag them to the desired left and right imits. The Left Limit and the Right Limit fields will be
filled in on the dialog box.

Click on the Calculate button.

Record the Onset value for temperature calibration and AH for heat flow calibration. If you
performing a heat flow calibration, you will need the AH values.

5. Repeat steps 1 — 4 for the zinc calibration run.

Once you obtain the Onset values, you can perform a temperature calibration,
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Performing Indium and Zinc Runs

In performing an indium and zinc run, you can use the precrimped, preweighed samples of indium and
zZinc or you can prepare your own samples for calibration. To perform the run, follow the steps below:

1. Place the sample pan containing indium or zinc in the sample area of the sample holder and place
the reference sample pan in the reference area of the sampie holder,

2. Using tweezers, cover the furnace with the inner and the outer furnace covers.

If not already displayed, select the Method Editor icon 124 from the toolbar.

From the File menu, select Open Method. The Open Method dialog box displays the methods
available in the default methods directory.

Select the IndCal.d6m method if using indium or ZincCal.dém if using zinc.

In the Sample Info page, fill in the sample information. Enter the weight of the indium or zinc sample
and the file name under which the data file is o be saved.

7. Click on the Start button | in the DSC 6 Control Panel to start the run.

The run starts. When finished, the data file will be saved with the file name that you entered in the
method.

After performing the indium and zinc runs, you must perform a peak area with onset calcuiation.




DSC 6 Help

Performing a Temperature Calibration

The measured Onset values for indium and zinc are used to calibrate the temperature of the DSC 6. To
perform the temperature calibration, perform the following steps:

1.

With either the Instrument Viewer or the Method Editor as the active window, select Calibrate from
the View menu. The Calibrate dialog box is displayed.

Select the Temperature tab.
Enter the name of the reference material that you used.

Enter the expected onset temperature for the reference material in the Exp. Onset field {e.g., 156.60
for indium).

In the Meas. Onset fisld enter the onset temperature that you obtained when you performed the peak
area with onset calculation.

Enter the method used for the calibration.
Select the check box in the Use column for each refarence material used in the calibration.

Select the Save and Apply button in the Calibration window to send the new calibration values to the
analyzer and save the current calibration file.

Go to the Heat Flow calibration procedure or select Clese to close the Calibration window and begin
using the new calibration valuss.
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Heat Flow Calibration

itis recommended that indium be used when performing a heat flow calibration. However, the heat flow
calibration can be performed using any one of the following materials:

Calibration Heat of Fusion
Substance (J/g)
Cyclopentane 8.60
Gallium 79.87
Indium 28.45

Lead 23.01

Tin 80.46

Zinc 108.37

While using the Instrument Viewer or the Method Editor, select Calibrate from the View menu.

2. Restore the default Heat Flow calibration by selecting Heat Flow from the Restore menu. if you
performed a Temperature calibration just prior to starting a Heat Flow calibration and selected All
from the Restore menu, then you do not need to restore the default Heat Flow calibration here.

3. Select Save and Apply.
Select Close in the Calibration window.
5. In Data Analysis, use the same data file obtained from the run in Obtaining an Indium and Zinc Run,

or perform a run using anather reference material.

6. Perform a Peak Area with Onset caiculation and note the AH resuft, or use the AH result recorded
for the reference material when you performed this step for temperature calibration.

7. You are now ready to perform a heat flow calibration.
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Sample Handling for the DSC 6

The DSC 6 measures differential temperature and reports the heat flow to the sample as it is heated,
cooled, or held isothermally. The following topics discuss the materials and techniques used to obtain
data with a DSC 6. Some tfopics contain videos illustrating the subject.

® @ & &

Sample Preparation

Sample Pans

Sample Encapsulation

Sampie Atmosphere

Loading the Sample into the DSC 6
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Sample Preparation for the DSC 6

For optimum results, observe the guidelines below when preparing your samples for analysis.

Sample Size

The size of samples that can be analyzed with the DSC 6 is limited only by the volume of the sample pan
you are using. Howsver, the sample size in conjunction with the scanning rate will affect the quality of
your resuits,

With the DSC 6, running a large sample at a faster scanning rate will improve the apparent sensitivity.
Running a small sample at a slower scanning rate will improve the resulting peak resolution.

Most samples run on the DSC 6 should be in the 5 - 30-mg range. Use small samples of 1 mg or less for
decomposition studies and other analyses in which the sample may tend to contaminate the sensor
disks. Small sample sizes are alsc recommended if the sample has not yet been investigated.

Temperature Range

The temperature range for your analysis depends on the sample and the type of experiment you are
performing. The DSC 6 can be used to analyze samples from a temperature of —120°C to 200°C when
used with cold nitrogen gas or from ambient to 450°C.

Heating Rate

The DSC 6 allows heating rates of 0.1 to 50°C/min in steps of 0.1°C/min. Proper selection of heating rate
will increase efficiency of your analysis at the desired sensitivity.

Generally, slower heating rates improve the peak resolution while faster heating rates improve the
apparent sensitivity. Heating rates greater than 40°C/min are generally used for rapidly heating or cooling
the DSC 6 1o the beginning temperature of the next segment or to selected isothermal temperatures in
the temperature program. Typical experimental heating rates range from 5.0 to 20°C/min. Slower rates
can be used for liquid crystals and purity analyses.

Samples

The DSC 6 analyzes both solid and liquid samples. Solid samples can be in film, powder, crystal, or
granular form,

Ta learn how to prepare a solid polymer sample for encapsulation in a sample pan, see Preparing a
Solid Polymer Sample

To learn how to prepare a liquid sample for encapsulation, see Preparing a Liguid Sample.

To fearn how to prepare a powdered sample for encapsulation, see Preparing a Powdered Sample.

The prepared samples are encapsulated in sample pans. Your choice of sample pan depends on the
nature of the sample and the temperature range of interest. A summary of sample pans and sealers {with
their Perkin-Elmer part numbers) available from Perkin—Elmer is given in DSC § Sample Pans and
Sealers,

NOTE: The standard aluminum sample pans and covers provided with your DSC 6§ are suitable for
most thermal analysis applications. Metal standards, such as indium, tin, lead, and zinc, must
be encapsulated in aluminum pans because they will alloy with copper, gold, or platinum pans.

After the sample has been prepared and placed in a sample pan, it must be encapsulated. The method of



sample encapsulation most widely used is crimping the sample pan cover in place. The normal ¢rimping
procedure yields a tightly but not hermetically sealed sample. For a detailed discussion of how to
encapsulate samples properly, see Sample Encapsulation,
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Sample Atmosphere

The DSC 6 has a Dry Gas Inlet and a Purge Gas Inlet at the rear of the analyzer. The Dry Gas Inlet
(external purge) purges the outer portion of the sample holder/neat exchanger assembly with dry gas.
This must be used whenever working below ambient temperatures. The dry gas, which is preferably dry
nitrogen, prevents condensation of water vapor on the measuring cell. A flow rate of 20 — 40 cc/min is
recommended for the external purge.

NOTE: There is no flow restrictor built into the analyzer. Therefore, it is necessary to use either an H
restrictor (P/N 0154-1498) or a Float Displacement Flow Meter (P/N 0290-1624) to obtain the

proper flow rates. }{{\g?@b\
NOTE: Itis not necessary to connect a dry gas provided you do not operats the DSC 6 below ambient

temperatures.
The Purge Gas Inlet (sample area) is used to purge the furnace. Argon or 99.9% minimum purity nitrogen
is recommended for purging the sample holders. Other gases such as air or oxygen can also be used.

The gas must be dry. The required flow rate should be between 20 and 40 cc/min. Use a size 1A cylinder
equipped with a pressure regulator that has a shutoff valve at the outlet.

When using both dry gas and purge gas, set the flow rates equal to each other (20 - 40 cc/min).

The TAGS (Thermal Analysis Gas Station) may also be used for automatic switching of four sample
purge gases using a predefined operation program that you set up in the method. You are allowed up to
ten gas changes per temperature program step with the TAGS.
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Loading the Sample into the DSC 6

Prior to loading the sample into the DSC 6 sample holder, the sample must undergo sample preparation
and encapsulation,
In addition to encapsulating the sample, it is recommended that a reference capsule be used in the

reference furnace during the DSC 6 experiment. The best reference material is an empty sample pan
and lid of the same type in which the sample material is encapsulated.

You load the sample into the DSC 6 as follows:

1. Open the sample holder by lifting off the two furnace covers with tweezers and placing them onto the
stainless-steel ring that surrounds the outer furnace cover.

Click here to view fiqure,

A CAUTION: Do NOT place the inner furnace cover onto the painted DSC 6 cover when it is hot. It
might damage the paint on the analyzer.

2. Using tweezers, place an encapsulated sample into the furnace on the sample side {left) and an
empty pan and lid of the same type used to encapsulate the sample on the reference side (right).
Make sure that the pans are centered on the sensors.

Click here 1o see figure.




Removing Outer and Inner Furnace Covers

Uuter Furnace Cover
S inner Furnace Cover
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DSC 6 Accessories, Replacement Parts, and Parts Provided

Supplies, accessories, and replacement parts for the DSC 6 analyzer ¢can be ordered directly from
Perkin-Eimer. PE XPRESS, Perkin-Elmer’s catalog service, offers a full selection of high-quality thermal

analysis supplies through the Thermal Analysis Supplies Catalog. To place an order, request a free
catalog, or ask for information:

@ If you are located within the U.S,, call toll free 1-800-762-4002, 8 a.m. to 8 p.m. EST.
@ Iif you are located outside of the U.S., call your local Perkin-Elmer sales office.
For a list of the parts provided with your DSC 8, see the DSC 6 Spares Kit.
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Rescaling

You can optimize the display of the data file by rescaling the X and Y axes of the Instrument Viewer or the Data
Analysis window, thereby displaying only a portion of the curve(s) in the window. There are three ways to
rescale:

1. Create a box around the portion of the curve you want to display by clicking on the mouse and dragging
it. While dragging, a box is created. Once the box is around the desired area, double click inside the
box. Both X and Y axes of the active curve are automatically rescaled. !f the Radar window also is
displayed while rescaling, its box is redrawn to reflect the new scaling.

This action rescales the X axis for all curves and the Y axis of the active curve. All curves using the
same Y axis as the active curve are also displayed on the new Y scale. All other curves are rescaled in
the X girection cnly.

2. You can resize the existing box in the Radar window. The curve in the Data Analysis window will be
rescaled accordingly.

3. Use the commands on the Display menu or the buttons in the Rescale Tools tcolbar to rescale: Rescale
X Axis, Rescale Y Axis, Fuli X Scale, Full Y Scale, Full Scale, and Previous Scale.

Shift Curves

You can shift any heat flow, baseline heat flow, or unsubtracted heat flow curve vertically along the Y axis using

the Shift Curve bution b on the Rescale Tools toolbar. This button is gray until a heat flow curve is
displayed, Shifting a curve vertically makes it easier to see differences between curves that are overlapping.
When you shift a curve, only the curve moves; the axes and scales do not change.

Select the curve you want to shift by making it the active curve, then select the Shift Curve button in the
Rescale Tools toolbar. The Shift Curve dialog box appears and an X appears on the active curve.

I~ dign

' { Cancel

The shift along the Y axis is defined by two points: the Shift From point and the Shift To point. The point at
which the X intersects the active curve is the Shift From paint. The Shift To point is the Y-axis value to which
you want to move the Shift From point. Use the mouse to drag the X to the desired Shift From and Shift To
points or type the values directly in the dialog box.

It you select the Align All check box, all curves in the active Data Analysis window that share the same Y axis
will shift to the point on the Y axis defined by the X. This is a quick way to shift more than one curve.

Change the Curve's Slope

You can change the slope of any heat flow, baseline heat flow, or unsubtracted heat flow curve using the

Change Slope button = on the Rescale Tools toolbar. When you change the slope of a curve, only the
active curve is affected; the axes and scales do not change.

Select the curve whose slope you want to change, then select the Change Slope button on the Rescale
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Tools toolbar. The Change Slope dialog box appears:

A line representing the siope is placed on the curve. The left end of the line is the pivot point and is identified by
a small box. The right end of the line is the slope point and is identified by an X. Use the mouse to drag the
pivot point and the slope point to the desired coordinates on the curve or type the X coordinates for each point
directly in the Change Slope dialog box. The values in the dialog box update automatically when you move the
pivot and slope point markers with the mouse. If you type the coordinates in the dialog box, the slope line on
the curve does not update until you click on OK. The pivot point must always be 1o the left of the slope point.

Align Endpoints automatically assigns the slope point and the pivot point to the same Y value, forcing the slope
line to be horizontal and the slope to be 0.

Annotate Curves

Another way 1o optimize the data curve display is to add informative and descriptive text labels. Either click on

the Annotate button Iz on the Rescale Tools toolbar or select Annotate from the Display menu to display
the Annotations dialog box. The labels you add can be saved with the data or used for display only. You can
create multiple labels for each curve. You can reposition, edit (e.g., change its font, color, and orientation), and
delete an annotation.

Top

Math, Caic, and Curves Menus

You can display additional curves based on the data represented by the active curve in a Data Analysis window
by using the items in the Curves, Math, and Calc menus. The new curve is added to the active Data Analysis
window. You can also display other curves in the Instrument Viewer.

The data saved from a run includes analyzer signals pertaining to certain parameters. For example, the sample
and program temperatures are saved for all analyzers. The heat flow is saved for DSC analyzers. Weight and
weight % are saved for the TGA analyzers. Probe position, static and dynamic forces, frequency, amplitude,
and phase angle are saved by the DMA 7e. In addition, for the DMA /TMA analyzers, other parameters such as
expansion coefficient, volumetric expansion, and modulus are alsc saved and can be displayed as curves in
the Data Analysis window. Delta T is saved for the DTA 7. These analyzer signal curves are on the Curves
menu.

In the Data Analysis application for all analyzers, you can display curves that are calculated using the data in
the active curve by selecting a command from the Math or Calc menu. The calculated curve is added to the
window and becomes the active curve. You can perform such calculations as obtaining the derivative, adding
curves together, subtracting, averaging, smoothing, peak area, glass transition etc. You can also smooth and
normalize the focused curve.

You can display data from one or more method steps rather than alf of the data in the active curve by selecting
the Step Select cornmand in the Curves menu. When you select this command, a checkmark appears next io
the command in the menu. As long the checkmark is displayed, Step Select is "on." Each time you select a
command in the Curves menu to display a different curve, the Step Select dialog box appears. Click on the
Select All button to highlight and select ail of the steps.
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Using Pyris Help C@

The online help for Pyris Software for Windows is now in HTML help format. HTML help topics appear on the
right side of the Help window, with scroll bars visible for further viewing. Navigation buttons are displayed
across the top of the window. A special nagivation pane appears on the left side of the Help window. it displays
tabs for the Contents, Index, and Search features.

Table of Contents

Most of Pyris Help is presented in the main help pane that you are looking at now, You can access other paris
of the help system by using the Table of Contents to the left. The Table of Contents is a summary of the Pyris
Help system with topics arranged by category. The Table of Contents' tree-fike outline that dispiays topics in
expandable/collapsible format is intended to provide you with a hierarchical view of the Help topics. The topics
are organized by category which is indicated by a book. If you double ¢lick on a closed book, or the "+ sign
next to the book, the book opens and the list of topics in the book is displayed. These topics are called pages.
A topic that is new to the Pyris Help since the previous release is indicated by a red asterisk (*}. The Table of
Contents is synchronized with the Help so that if the topic you are in is a page in the Contents, that location is
automnatically highlighted in the Contents. Other forms of help in Pyris Software for Windows are context-
sensitive help and Quick Help.

Index

Another feature of Pyris Help that helps you get around is the Index which visually displays an alphabetic list of
all keywords associated with the Help system. The Index is visible while you are viewing the topic associated
with that index entry.

Search

Pyris Help supports fuli-text searching. The left pane of the Help window contains a Search tab along with
Contents and Index. To use the full-text search feature, click on the Search tab. Enter the word or phrase that
you are looking for in the space at the top and click on List Topics. The Help system will go out and find all the
topics that contain that word or phrase and will list the topic titles in the Topic list. Find the fopic you want to
display and either double click on it or highlight it and cick on the Display button to dispiay the topic in the right
pane.

Contexi-Sensitive Help

Context-sensitive help lets you get information about any screen, menu command, dialog box, o toolbar button
in Pyris Software for Windows. 1t provides specific information at precisely the place in Pyris where you want to
find it. Pyris Software for Windows has "window-ievel help” or Help button or F1 help. Window-levet help
provides an expianation of all the items in a dialog box or window within one Help topic. In addition to the Help

button and F1, you can activate context-sensitive help by clicking on the Context-Sensitive Help button @in
the Pyris toolbar, The cursor changes 1o an arrow with a guestion mark. Place the arrow on the scréen, dialog
box, menu command, or toolbar button about which you want information. A help topic describing that item
appears in the help window.

In some context-sensitive help topics there may be a @ bution at the bottom of the topic. Click on this to
display a "now to" topic related to the current topic. For example, if the current topic is Temperature Calibration
for the TGA 8, this button will connect you 1o the topic in Hardware Help that discusses exactly how to perform
a temperature calibration for a TGA 6.

Quick Help

Quick Help includes quick and easy procedures for using the Pyris Manager, calibrating analyzers, performing
a DMA analysis, performing a purity analysis, determining lag or rate compensation, and creating play lists,
Some topics contain videos that show what is happening on the screen while these steps are performed. Quick
Help is displayed in its own window.
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Multimedia Help

Muttr=adia Help comprises topics that include multimedia clips that are on the Pyris Software for Windows CD.
The €O must be in the CD drive when you use Multimedia Help. The topics cover such topics as preparing
sarress for use with a DSC analyzer, how to install a hangdown wire in a TGA 7, and so on. The topics are
usefid when using Hardware Help.

Gettimg Started

The Pymis Software for Windows group of items is accessible by selecting Programs from the Start menu in
Wincowss 95 and NT. During instaliation you can elect to place a shortcut to the Pyris Manager on the Start
Mecwu or on the Windows desktop. ltems in the Pyris Software for Windows menu reflect how the software is
organized. They are as follows:

> Pyris Configuration

Uss Pyris Configuration to dynamically configure the analyzers in your system. Pyris Configuration can be
opermed from the Pyris Manager Start Pyris button or from the Pyris Software for Windows program group.

> Pyris Data Analysis Application

This application analyzes data collected by any analyzer. This application is not associated with a particular
anayzer and can be used to analyze data and edit methods for any instrument attached to your thermal
araysis system. More than one Data Analysis Application can be opened at a time.

> Pyris Help

All it the documentation necessary for operating the Pyris Series Thermal Analysis System is provided
oniime. Help contains complete descriptions of all of the software’s features in addition to information on
ma‘iaining and optimizing your analyzers.

> Pyris Installation Help

Pyrs Instaltation Help provides step-by-step procedures for installing all thermal analyzers and accessories
supoorted by Pyris.

> Pyris Manager
The Pyris Manager provides access to the Instrument Application for each configured instrument in your

sysiem. From the Start Pyris button in Pyris Manager, you can also access the Data Analysis application,
moritor the system status, run Pyris Configuration, access Pyris Help, and close all Pyris-refated windows.

> Pyris Readme

This text file contains the latest information on the version of Pyris instalied cn your computer. 1t lists the

new features included in the software and any information on the software or hardware that did not get
included in the online Help.

> Pyris Uninstaller

This tool is used to remove all Pyris Software for Windows files from your system. You must use this utility

before installing a new version Pyris. It does not remove data, method, calibration, or play list files,
however.

> Temperature-Dependent Crystallinity

Temperature-Dependent Crystallinity is a third-party application that is used with Pyris data. It can be
accessed either from the Calc menu in Data Analysis or from the Pyris Software for Windows menu, it has
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its own Help and Readme files.

Quick Help | Remote Monitor
Standard Window Components ]

The standard window components are as follows:
»Title Bar
»Status Bar

>Maximize Bution

>Minimize Bution

»Vertical Scroll Bar
>Horizontal Scroll Bar

>Left Window Border

»Right Window Border

>Top Window Border

»Top Left Window Border
>Top Right Window Border
»Beottom Window Border
»Bettom Left Window Border
»Boltom Right Window Border

»Print Preview Toolbar

»Context-Sensitive Help Bution

»Control Menu

Customizing Pyris

You can customize Pyris Software for Windows to suit your needs. You can change the way the screen looks,
how curves are displayed, and the default values for many program parameters.

Dockable Toolbars, Status Panel, and Control Panel

All toolbars — standard, Pyris, and Rescale Tools ~ and the status panel can be attached 1o any side of the
Pyris window or they can “float” over the window. The control panel can be attached to the left or right side of
the Pyris window. When a toolbar, the status panel, or the conirot panel floats, it has a title bar.
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Click on the background of the toolbar or panel and drag it to the desired location. When you drag a dockable
toolbar or panel to any edge of the Pyris window, it becormnes attached to that side.

Customizing the Status Panel

The Status Panel consists of boxes each of which contains a parameter name and that parameter's current
value. Each box contains a drop-down list of parameters from which you select the parameter to be displayed
in that box. As soon as you select a parameter, its current value is displayed in the lower part of the box. If you
highlight the entry field in the status panel and then type the first lstter of another parameter, e.g., fora DTA 7
fype an "}, then that parameter, or another parameter that begins with that letter, will be displayed. So for a
DTA 7, if you continuously type “f” the parameters Furnace Cover, Furnace Lock, Furmace Status will be
displayed. You can scroli through alf parameters starting with that letter by contintously pressing that key.

The Status Panel must contain at least one parameter box. To resize the status panel, i.e., to eliminate or add
a parameter box, first detach the status panel from the window frame {click on it and drag it away from the
window frame), then click and drag the status panel border to include or exclude a box.

Customizing the Curves Display

Pyris Software for Windows supports right-click menus in the graphics displays, i.e., Instrument Viewer and
Data Analysis. You can customize the display using the items available on these menus.

2]

Using the Pyris Manager '

The Pyris Manager is the main location from which to operate the Pyris Series Thermal Analysis System. The
Pyris Manager is used to start instrument applications and Data Analysis applications can be initiated from
there. Analyzers can be added to and removed from the system dynamically with the Configuration utility which
is accessed from the Pyris Manager task menu. The status of each analyzer in the system can be monitored in
Pyris Manager as well.

To open the Pyris Manager

Double click on Pyris Manager in the Pyris Software for Windows folder in the Programs menu which is
accessed via the Windows Start button. A shortcut to the Pyris Manager may be on the desktop and/or in the
Start menu if either or both of these options were selected during installation.

Displaying the Pyris Manager
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The Pyris Manager can be displayed horizontaily or vertically on the screen. if it is horizontal and you want it
displayed vertically, just click on and drag the Pyris Manager down info the middie of the screen; it will redisplay
vertically. To change from vertical to horizontal display, place the cursor in the Pyris Manager (but not on an
instrument button or the Start Pyris button), click on and hoid down the left mouse button, and start moving
the mouse to the lefi, to move the Manager from across the top to down the left-hand side of the screen. Or
start moving the mouse to the top and the right to move the Pyris Manager from the left side up to across the
top of the screen. If the Autohide feature is activated, the bar shrinks to a smaller area as it is moved. Just the
Siart Pyris button is displayed.

Place the cursor within the Pyris Manager and click on the right meusse button o display the Pyris Manager
popup menu:

« Select Always on top to keep the Pyris Manager available for display. How it behaves depends on
whether Autohide is activated. When Always on top is activated, a checkmark appears next to item.

+ Sefect Autohide to have the Pyris Manager “hide” when in Pyris or another application such a word
processor. Always on top must be selected. When both are activated, the Pyris Manager will roll off of
the screen so that it does not take up room on your display but it is always available. For example, if it is
displayed horizontally and moved to the bottom of the screen and you move the cursor up into the
screen, the Pyris Manager wili roil off of the screen. Bring the cursor back to the bottom of the screen,
by the Windows taskbar, and Pyris Manager will reappear. If you select Autohide when Always on top is
no! selected, the Pyris Manager will close automatically when you select an Instrument Application.
When activated, a checkmark appears next to the item in the popup menu.

e You can change the display of all your open Pyris windows by selecting Cascade, Tile Horizontally, or
Tile Vertically. These are the standard Windows features. Selecting any of these options does affect
non-Pyris windows.

e You can minimize all open Pyris windows to the taskbar at the bottom of the screen by clicking on
Minimize All. Redisplay in maximum size all Pyris windows that are indicated on the taskbar by clicking
on Maximize All in the popup menu. Restore All restores all Pyris windows to their original position and
size before they were minimized or maximized.

Features of the Pyris Manager

The Pyris Manager contains a Start Pyris button and a button for each configured instrument on your system.
Beneath the Start Pyris button are left and right arrow buttons if the Pyris Manager is horizontal and up and
down arrow buttons if the Pyris Manager is vertical. These are used to scroll the instrument butions left or right
or up and down if there are more butions than can be displayed on the screen. Click on the Start Pyris button
to display the Pyris Task menu:
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e Access Data Analysis Applications from here rather than from the Frograms menu,

» Open and run Pyris Configuration to dynamically add an instrument 1o or remove an instrument from the
systemn. Each configured thermal analyzer is represented by a button on the Pyris Manager.

e Open online Pyris Help by clicking on Help.
o Close all Pyris windows via Close All.
The instrument buttons on the Pyris Manager are used fo enter the Instrument Application. They are also used

to monitor the status of the instrument. If you place the cursor within the button but not in a display field and
click on the right mouse button, the Change Status Information dialog box appears:

[Sample Temp

Status Line 2 ;Status

Here you can change the information displayed on the instrument button. Display the drop-down menus for
both status lines and select the parameter you want displayed. The list of available items for both status lines is
instrument-dependent.

&

Quick Help
Navigating in Pyris Software for Windows

It is easy to navigate around Pyris Software for Windows' components. You can go from Instrument Viewer to
Methed Editor to Data Analysis and other parts by a click of the mouse on the standard toobar. The first four
buttons on the standard toolbar are used to navigate between the four major parts of Pyris.

When a window such as Pyris Player or Calibration displays tabs, indicating that there are pages that make up
the window, click on the tab to display the page on top of the other pages.

Another way to navigate is the use of the menu bar. Each menu item contains a specific drop-down list
dependent on the analyzer and the window displayed.

Pyris 1 DSC Configuration
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The gas program can have the GSA 7 swiich the purge gas at a selected time.

o No Gas Accessory

The other accessories available for selection by clicking on the check box are

CCA 7 Controlied Cooling Accessory: The CCA 7 allows low- temperature operation of the DSC 7 to -
140°C (and to -70°C with a DSC 7 Robotic System).

High-Pressure Cell: This accessory is used for performing DSC experiments at elevated pressures. It has
built-in connections for a liquid cooling system such as tap water or a circulating system.

DPA 7 Photocalorimetric Accessory: The DPA 7 allows samples contained in the DSC 7 to be exposed
to full spectrum or individual wavelength UV light. Pyris-controlied shutter provides reproducible exposure
times. Multiple lamp source capability allows selection of the appropriate UV lamp for experiments.
Selection of this accessory is reflected in the Program page of the Method Editor where the Gas Change
butten changes to Lamp Change.

Autosampler: Select this accessory if you are using the DSC 7 Robotic System. If you connected the
autosampier directly into the COM1 or COM2 port on the computer via an RS 232 cable instead of to the
AUX port on the TAC 7/DX, indicate that port in the Port field.

Firmware Version

Displays the version of firmware in the analyzer.

Hardware Help
DSC 6 Configuration

The DSC 6 Configuration dialog box appears when you select the Edit button in the Pyris Configuration dialog
box when the DSC 6 analyzer is highlighted in the Analyzers list. 1t is also displayed when there is a DSC 8
attached to the computer and it is detected by the Pyris software when you select the Add button in the Add
Analyzer dialog box. The analyzer must be powered on when you configure it into the system; otherwise, it will
not be recognized when you select the Add button. The fields in this dialog box are as follows:

Name

It you are adding a DSC 6, the system will display a default name in this field. Type the name you wish to
assign to the analyzer, usmg & maximum of eight characters. The name identifies the analyzer in Pyris
Software for Windows; it also appears in the Instrument button on the Pyris Manager panel and in the title
bar of the Instrument Application.

Port

Displays the COM pert to which the analyzer is attached and that you selected in the Add Analyzer dialog
box.

Serial Number
You can enter the serial number of the analyzer for further identification; it is not a required entry.
Accessories

Lists the available accessories for the analyzer. For the DSC 6, the only accessory is for purge gas. Click
on the drop-down arrow to display the available choices:
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+ Thermal Analysis Gas Station (TAGS): Select this accessory if a TAGS is attached to your
analyzer. The TAGS can control up to 4 purge gases. Selection of this accessory is reflected in
the Gas Change box on the Program page of the Method Editor. The gas program can have the
TAGS switch from one gas to another at selected times or temperatures. The flow rate can also
be changed.

e No Gas Accessory

Firmware Version

Displays the version of firmware in the analyzer.

Hardware Help
TGA 7 and Pyris 1 TGA Configuration

The Configuration dialog box for a TGA 7 or a Pyris 1 TGA appears when you select the Edit britton in the
Pyris Configuration dialog box when either analyzer is highlighted in the Analyzers list. It is ajdo displayed when

select the Add button in the Add Analyzer dialog box. The analyzer must be powered onvhen you configure it
into the system; otherwise, it will not be recognized when you select the Add button. JHe fields in this dialcg
box are as follows:

1 | [Themal Analysis Gas Sttion (TAGS 7]

‘rrhccessaries:

_’Ne Gas Accessory

. Sesiel Number
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@ Setup Page

@ Edit Play List Page

@ View List Page

@ View Sampie List Page

® View History Page

@ Sample History Page

@ Piayer Toolbars

Top
DSC 6 instrument Appiication

The main parts of the DSC 6 Instrument Application are
» Instrument Viewer

» Method Editor

» Data Analysis

> Pyris Player
> Status Panel

» Control Panel

To move from one part of the Instrument Application to another, you can use the toolbar buttons:

Instrument Viewer
Method Editor
Data Analysis

]f;".l Pyris Player

instrument Viewer

The Instrument Viewer is a window that displays the real-time signals from the DSC 6 as data are collected
during a run. You can select the curves (signais) for display from the Curves menu. If there is no run in
progress, the instrument Viewer can be used to monitor the status of the instrument by activating Monitor from
the View menu. If you click on the Reset Monitor button in the control panel, the display in the Instrument
Viewer is cleared and monitoring begins again. The display of the curves can be optimized by using the rescale
toois on the Rescale Tools toolbar.

The Instrument Viewer window contains a title bar, control box with the standard Controi menu, Minimize and
Maximize buttons, and a border that can be used for resizing. The curves displayed in the window can be
changed by selecting items on the View, Display, and Curves menus,

Method Editor

The DSC 6 method is a set of parameters that determine the conditicns under which the system wilt colfect
data on a sample. Any number of methods can be created and stored so that the parameters can be optimized
to handie different analyses. Methods are also used in play lists. The play list can be set up to run many
samples using the same method via the sample group. The Method Editor comprises the following pages,
each of which contains its own set of parameters:
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@ Sample Info Page
@ [nitial Siate Page

@ Program Page
Another feaiure of the Method Editor is the Thermal Program Window.

Data Analysis

The Data Analysis window is opened one of two ways: First, you can select Data Analysis from the Start Pyris
Task menu or from the Pyris Software for Windows group in the Programs menu. The window displays the fast
data file dispiayed there. Use the options on the File menu to display data files collected by different analyzers.

Second, the DSC 6 Data Analysis window is opened while in the Instrument Viewer or Method Editor by

selecting the Data Analysis button @ from the toolbar. From the Open Data File dialog hox sselect the data
file you want displayed. Use the items in the File menu 1o open, add, close, and save a data file or to print the
display.

The View, Display, Curves, Math, and Calc menus are used to change the display and the type of curve and to
perform calculations on the data for additional information.

The Data Analysis window also contains the standard window items: title bar, control box with Control menu,
Minimize and Maximize buttons, and a border that can be used for resizing.

Pyris Player

Pyris Player is used to creatle play lists or sequences of commands that automate data collection and postrun
data analysis functions. You can create a play list that prompts you through the steps necessary rorun a
sample or a series of samples (i.e., Load Sample, Start Method, Remove Sample} and then performs a series
of analyses on the data files, displays the results, and prints the results. Pyris Player's Sample Group feature,
which includes a Sample List and a Data Analysis List, simplifies creation of a play list. For each Sample line in
the Sample List, the program will pause in order for you to load or remove the sample since it does not detect
an autosampler. The Sample List is a good way to group similar sampies together to be analyzed by the same
method. The items in the Data Analysis List can take the data file from the current run, preceding play list
fterns, and existing files and perform the same procedures that are available in regular Data Analysiin a play
list.

While a play list is running, you can perform cther functions on your computer or pause the play list to edit
entries below the current line. A complete history file is generated that contains the record of success or failure
of each itern in the list. If an error occurs, a reason is listed. There also is a sample history page that displays
past and current information on the samples in the Sampte Lists in the current play list.

See the following topics for more details on the parts of Pyris Player:
@ Setup Page
@ Edit Play List Page
@ View List Page

@ View Sample List Page

¥ View History Page

@& Sample History Page

& Player Toolbars
Top

ent Application

To learn more about the main parts of the TGA 7 Instrument Application; each of the topics below:
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conditions that you run your samples. After each run is completed, perform a Peak Area calculation and
inclde the Onset temperature. Record the AH (J/g) and Onset results; you will need the Onset result for
rature calibration and you can use the AH result for Heat Flow calibration.

f the reference materiais have been run and calculations performed, enter the reference material
name, expected onset temperature, measured onset temperature, and calibration method name in the table on
the Temperafiue page. Click on the check box in the “Use” column for each reference that is to be used in the
calibration.

When all of the inforination has been entered, click on the Save and Apply button 1o save the calibration
values and apply them>Go on to the next calibration procedure or select Close to close the Calibration window
and begin using the new c¢glibration values.

If you are performing a Furnade calibration next (if your DSC 7 has the DDSC instalied), it is essential to Save
and Apply the new Temperaturé-calibration first.

Heat Flow Calibration

w page of the Calibration window. A Hea! Flow calibration uses
can be slightly modified by running a new reference sample

Select the Heat Flow tab to display the Heat
a single standard. The Heat Flow calibration val
while the existing calibration is applied.

can for the reference material under the same
completed for the Temperature calibration. After
rd the AH (J/g)} result.

Enter the reference material name, expected AH, measured AH,
calibration method name in the Calibration table.

To perform the DSC 7 Heat Flow calibration, complete
conditions that you run your samples or use one of the sca
the run is completed, perform a Peak Area calculation and re

gight of the reference material, and

When all of the information has been entered, click on the Save and Apply button to save the calibration
values and apply them. Go on to the nexi calibration procedure or select Close to close the Calibration window
and begin using the new calibration values,

Furnace Calibration

The Furnace Calibration is available for a DSC 7 if the DDSC accessory is instalied. This calibration linearizes
the DSC 7 furnace by matching the program temperature to the sensor temperature over the Ynge that you
enter. If you have just completed a Tempsrature calibration procedure, you must Save and Apply the new
Temperature calibration before starting the Furnace calibration.

Select the Furnace tab to display the Eumace page of the Calibration window. Enter the minimum and
maximum temperature limits, then select the Begin Calibration button and follow the instructions in the &
box. To accept the Furnace calibration values, click on Save and Apply.

Quick Help | DSC 7 Hardware Help

DSC 6 Calibration l@"’
There are two calibration routines for a DSC 8:

@ Temperature

@ Heat Flow

it is recommended that a baseline correction be performed before temperature calibration.

The DSC 6 analyzer has been calibrated at the factory for both temperature and heat flow. Under normal
conditions, the DSC 6 does not need temperature recalibration. Temperature calibration and heat flow
calibration should be checked using the precrimped samples of indium and zinc before obtaining data. Some
conditions that could affect the current calibration of the DSC 6:

1. It the operating range of your experiments changes, you may need to recalibrate the temperature. Run a
standard in the new range of interest to determine if the current calibration is valid.
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2. it you change the purge gas type or flow type, verify that the temperature is stil calibrated.
if vou change the coolant, you may need to recalibrate.

{f the DSC 6 has been turned off for a fong time (i.e., weeks or months), it may appear to reguire
recalibration. if so, condition the analyzer by performing several heating and cooling runs with an empty
sample holder, then check the calibration by running standard materials.

Before calibrating the DSC 6, it is sometimes necessary to restore default calibration values. Typically, it is
better to restore defaults when you are changing the temperature range that you are using. If you are changing
the purge gas or flow rate, or if the analyzer has not been used for some time, restoring defaults may be
necessary. The Temperature calibration can be slightly modified by running a new reference sample while the
existing calibration is applied. You can restore default calibration values by selecting the appropriate calibration
routine from the Restore menu while in the Calibration window. You can even restore all calibration vaiues by
selecting All. This activates the Save and Apply button; click on it and then, in the Save As dialog box, select
the calibration file to be used or enter a new file name under which to save the values displayed in the
calibration window.

For Temperature and Heat Flow calibrations, run high-purity reference materials (typically indium and zinc) with
known temperature and energy transitions. The data obtained from these runs are used in the Pyris software
calibration routines to calibrate the DSC 6. Once the analyzer is calibrated, it will remain calibrated even when
the system is turned off, as long as there are no changes in the operating conditions.

Temperature Calibration

Select the Temperature tab to display the Temperature page of the Calibration window. f you are restoring
default calibration values, do so before completing the reference material sample runs,

To perform the DSC 8 temperature calibration, complete a scan for each reference material under the same
conditions that you use to run your samples. After each run is completed, perform a Peak Area calculation and
include the Onset temperature. Record the AH (J/g) and Onset results; you will need the Onset result for
Temperature calibration and you can use the /AH result for Heat Flow calibration.

When all of the reference materials have been run and calculations performed, enter the reference material
name, expected onset femperature, measured onset temperature, and calibration method name used in the
table on the Temperature page. Click on the check box in the “Use” column for each reference that is to be

used in the calibration.

When all of the information has been entered, click on the Save and Apply button to save the calibration
values and apply them. Go on to the next calibration procedure or select Close to close the Calibration window
and begin using the new calibration values,

Heat Flow Calibration

Select the Heat Flow tab to display the Heat Flow page of the Calibration window. A Heat Flow calibration uses
a single standard. The Heat Flow calibration value can be slightly modified by running a new reference sample
while the existing calibration is applied.

To perform the DSC 6 Heat Flow calibration, complete a scan for the reference material under the same
conditions that you run your samples or use cne of the scans compieted for the Temperature calibration. After
the run is completed, perform a Peak Area calculation and record the AH (J/g) resutt.

Enter the reference material name, the expected AH, the measured AAH, the weight of the reference material,
and the calibration method name in the Calibration table.

When all of the information has been entered, click on the Save and Apply button to save the calibration
values and apply them. Select Close to close the Calibration window and begin using the new calibration
values.

DSC 6 Hardware Help

DDSC Calibration ‘@”'
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Onset temperature. Do the same for the gold reference material. Select the Temperature tab in the Calibration
window to disptay.the Temperature page. Enter the information in the Temperature page and select Save and
Apply to send the n alibration values to the analyzer and save the calibration file.

Heat Fiow Calibration

Two high-purity standards are used to caibrate AH. This calibration is used to run in the DSC mode or when
data collected in the DTA mode needs to be cohwvgrted o Sample Heat Flow data.

To perform the Heat Flow calibration, accurately weighhe reference material. The accuracy and precision to
which you weigh the reference material relates directly to the accuracy and precision of the energy
measurements made on the DTA 7. Complete a scan of the réference material and perform a Peak Area
calculation and note the AH result. Select the Heat Flow tab in thé*Calibration window to display the Heat Flow
page. Enter the information and select Save and Apply to send the néw.galibration values to the analyzer and
the save the calibration file.

Furnace Calibration

This calibration performs a nine-point temperature calibration between user-selected limits. ust be
performed after the Temperature calibration. Remove the cups from the sample and reference ers. Select
the Furnace tab in the Calibration window to display the Furnace page and enter Minimum and Maxitrum
temperatures. Click on Begin Calibration and the Fumnace calibration will start; it takes up to 2.5 hours. Sglect
Save and Apply o send the new calibration values to the analyzer and save the calibration file,

Quick Help | DTA 7 Hardware Help

Running Samples m

In Pyris Software for Windows, each analyzer's Instrument Application contains a Method Editor, Control
Panel, Instrument Viewer, and Status Panel. To run a sample using any analyzer, each of these paris of the
software is used.

Using the Pyris Player feature of Pyris Software for Windows, you can create play lists that automate data
collection and analysis for an analyzer with an autosampler, Play lists can also be created for analyzers without
autosamplers. These lists would automate postrun data analysis on existing data files. -

In general, the procedure for a typical experiment includes the following steps:

Start the Pyris system.

From the Pyris Manager, start the specific analyzer's Instrument Application.

in the Method Editor, select an existing method or create a new method.

Load the sample in the analyzer.

Start the run from the Control Panel.

Monitor the rurv's data collection in the Instrument Viewer and using the Status Panel.
Save the data.

L N @Ok W

Perform postrun analysis.

A play list for an analyzer with an autosampler can automate steps 3 through 8. All you need to do is prepare
the sampler, place samples in the sample tray, set up the play list, and start the run.

See how parts of the Pyris software are involved in running samples:
> Methods

> Pyris Player

» Control Panel
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> Monitoring Data Collection

Quick Help
Methods

A method is a set of parameters that determine how the system will collect data on a given sample. Any
number of methods can be generated and stored so that the parameters can be optimized to handle different
analyses. A default method is included with Pyris Sofiware for Windows. You can edit this method and then
save it under a new method name.

Methods are created and managed in the Method Editor. The Method Editor can be opened in both an
Instrument Application and the Data Analysis Application by selecting the Method Editor button in the toolbar (

==3). In an Instrument Application, you can edit only those methods that conirol that instrument. In the Data
Analysis Application, you can edit a method for any insirument attached to your system. You can load a
method for another instrument type while in Data Analysis by using the Open Methoed command from the File
menu. In the Open Method dialog box, select the instrument type from the List Files Type box and then select a
fite from the list of available methods.

Methods can alse be part of a play list created with Pyris Player. Just as with individual runs, the methods in
the list contain the information necessary to run the sample that has been loaded into the sample holder via a
Load Sample entry in the play list.

The Method Editor contains three tabbed pages in which you enter information needed for the sampie run. The
parameters displayed on each page depend on the analyzer. The three pages of the Method Editor are

Sampie Info Page

This page contains information about the sample to be run such as operator ID, sample name, weight (for TGA
analyzers}, dimensions (for DMA/TMA analyzers), measuring system and geometry of the sample (DMA/TMA
analyzers}, and location and name of the file in which to save the run's data. If you do not fill a location and file
name, Pyris will use the defaults entered in the Save page of Preferences.

Initial State Page

This page contains the settings to be used at the start of the run such as temperature, forces, force controls,
purge gas selection, equilibration, and baseline file.

Program Page

This page is where you set up the temperature and time program and the gas program for your sample run.
Some information displayed on this page reflects entries made on the Initial State page. The main section of
this page is Method Steps. You add, insert, or delete individual steps to build the temperature and time
program. Steps are selected from a drop-down menu. The method steps are listed in order as you create the
program. For a DDSC, when you select DDSC Repeated Scan step, the entire program created up to that point
is replaced by the Repeated Scan step. For a DMA, if you select a Frequency, Dynamic Force, or Static Force
Scan step, the entire program is replaced by that step. You can also create a program and then select Repeat
Steps from the menu and have the program repeated. The page also contains scan rate, end conditions, and
the purge gas program.

The method's file name {(or "Untitled” if the method has not been saved), the sample ID, and the data's file
name are displayed at the top of each page of the Method Editor.

Pyris Player m

The Pyris Player is used o create a play list of steps that control an analyzer with an autosampler. In general, a
play list’'s steps tell the analyzer/autosampler to load a specific sample from the sample tray, start a method,
unload the sampie, and perform postrun analyses and display specified curves. Pyris Player can also be used
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with an instrument that does not have an autosampler, Play lists can be created that automate postrun
activities.

The Pyris Player features are

s ability 10 perform other tasks while a play list is being run
e ability to edit the currently running play list
s complete history files generated {o record success or failure of each itern in a list

o ability to create a list of samples that are to be analyzed with the same method and then have the data
files analyzed using the same data analysis list.

The Pyris Player is accessed in instrument Appiication or Data Anaiysis by ciicking on the Pyris Player button {

lfg’_!) on the standard Pyris toolbar. The Pyris Player consists of six tabbed pages: Setup, Edit Play List, View
List, and View History.

Setup Page

If you open Pyris Player while in Data Analysis, the Setup page allows you o select which instrument you
would like to control with the player. If you open Pyris Player while in Instrument Application, the Player is used
for the current instrument only.

Edit Play List Page

This page is where you create and edit play lists. The list is displayed in a format like that used in Windows
Explorer. The folders are Prepare Sample, Sample Group, and Data Analysis. These folders contain tems
such as Load Sample, Start Method, Pause, or Display Curve. Sample Group contains two sections: sample
list and data analysis fist. if a folder item has a plus sign next to it, click on the plus sign 1o display the folder's
conients; the plus sign changes to a minus sign. Click an the minus sign and the item folds up its list. An item's
relation to a folder and the folder's reiation to the entire list is shown by dotted lines. Use the Add a step,
Insert a step, and Delete this step buttons to create and edit the play list.

View List Page

This page displays the play fist in a manner similar tc that shown in the Edit Play List page, i.e., use the “+” and
“~* signs to open and close parts of the list. Since the page does not have the Edit Steps section, there is more
room for displaying the play list. The View List Page is for viewing purposes only.

View Sample List

This page displays in spreadsheet format the list of samples in a sample group in the current play list. The
columns in the spreadsheet are sample ID, file name, method used, carousel location of the sample, and the
sample's weight.

View History Page

This page displays the history of the playback of the play list. Each time the play list is run, the system records
the success or failure of each step. The play list is displayed in the same format as in the Edit Play List and
View Play List pages except that the “+” and the “~* signs are replaced with other symbols that indicats if the
item was completed successfully. A history file can be deleted from the list.

View Sample Historv Pade

This page is the same spreadsheet as seen in View Sample List except for the additional column before
Sample ID. This column contains a code that indicates the status of the sample's run: O = OK, S = Skip, and X
= Error.

When you enter the Pyris Player, the standard toolbar is replaced by the Pyris Player standard toolbar and a
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control bar.

Top
Quick Help
Controi Panel m

Each Instrument Application window contains a Control Panel on the right side. This panel is dockable and its
display can be toggled on and off from the View menu. It contains buttons that directly control parameters
specific to the analyzer. Some parameters can be set in both the Method Editor and the Conirol Panel. A
change in one place is reflected in the other. Use the Control Panel to start and stop a run, change the furnace
temperature, change the purge gas, zero the weight, zero the height, apply forces, hold the probe, or hold the
temperature.

See the {opics below to learn about the Control Panel for each analyzer:
> Pyris 1 DSC Control Panel

» DSC 7 Control Panel

»> DSC 6 Control Panel

» TGA 7 Control Panel

> TGA 6 Control Panel

> DMA 7e Control Panei

» TMA 7 Control Panel

» DTA 7 Controi Panel

» Pyris 1 TGA Contro] Panel

Monitoring Data Collection m

While a method is running, the data collected is presented in graphical form in the Instrument Viewer. You can
aiso see the status of selected instrument parameters or signais as curves if Monitor is activated. The status of
the instrument's parameters is seen as well in the Status Panel. If you have multiple analyzers running, you
can use the instrument buttons on the Pyris Manager to monitor the status of each analyzer while you do other
work.

instrument Viewer

The Instrument Viewer is a graphical window that displays the collected data in real-time during the run, as well
as the status of selected analyzer signals in graphical form. For example, for a DMA 7e, you can display the
Frobe Position, Sample Temperature, Dynamic Force, and other parameters as a function of time. When a
method is not running, the Instrument Viewer can display real-time baseline signals from the analyzer. You
select what signals to display from the Curves menu. You can remove a curve from the dispiay by selecting the
curve and then pressing the Shift + Delete keys simultaneously. Stop the display of all selected curves in the
Instrument Viewer by selecting Monitor in the View menu or the Reset Monitor button on the control panel.
You can change the color, line style, and plot type of the curve by right-clicking on the curve and selecting the
apprepriate option from the popup menu displayed. You can change the axes labels and titles by right-clicking
near the X or Y axis and selecting the option from the popup menu. You can toggle the grid lines on and off by
right-clicking within the Instrument Viewer and selecting the option.

You can use the rescaling tools on the Rescale Tools toolbar or the rescaling options in the Display menu to
redisplay the selected analyzer information and the real-time data.

Status Panel

The Status Panel is a dockable panel that appears in each Instrument Application window and Data Analysis
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window. It is made up of boxes each of which displays a parameter and its current value, e.g., Probe Position
for a DMA 7e. Select the parameter to be displayed in the box from a drop-down list of parameters. As soon as
you select a parameter, its current value is displayed. You can also highlight the display field and type in the
first letter of a parameter. For exampis, if you using 2 DTA 7 and type in “f" in a Status Panel box, one possible
parameter that can be displayed is Furnace Lock. Type “” again and Furnace Cover or Furnace Status will be
displayed.

The Status Pane! must contain at least one parameter box. To resize the Status Panel, i.e., to eliminate or add
a parameter box, first detach the Status Panel from the window frame (click on it and drag it away from the
window frame), then click and drag the Status Panel border to include or exclude a box.

You can hide the Status Panel to allow more room for other windows that are displayed beneath the Status
Panel, e.g., the Initial State page in the Method Editor. Select Status Panel from the View menu to toggle the
" panel off.

Click here to see an example of the Status Panel while a run is in progress.

Using the Monitor

You can monitor the status of an analyzer in the Instrument Viewer before the start of a run by selecting the
Monitor command in the View menu. The Monitor command toggles the monitoring feature on and off. A
checkmark appears next to the command in the View menu when the Monitor is on.

You can select what to monitor in the Instrument Viewer by selecting an item from the Curves menu. For
example, for the DMA 7e you can display curves for probe position, static and dynamic forces, frequency,
sample and program temperatures, amplitude, and phase angle. You can remove a curve from the monitor by
selecting it and pressing Shift + Delete simulianeously. The Y-axis label is also removed.

Select Auto-Rescale in the Display menu to have Pyris scale the curve automatically. i you want to rescale
the curve, use the Rescale Tools toolbar or the items in the View menu.

To clear the data in the Instrument Viewer, select the Reset Monitor button et in the Control Panel. The

Instrument Viewer will clear and the Monitor will restart.

Pyris Manager

You can use the Pyris Manager to monitor the status of multipie analyzers. Go to the Pyris Manager and
display the Pyris Manager popup menu by placing the cursor in the background area of the bar and clicking the
right mouse button. Select Always On Top to keep the Pyris Manager bar displayed on top of alt open windows.
Reposition the Pyris Manager to a more convenient place on the screen by clicking and dragging.

Each analyzer button on the Pyris Manager has two status lines. The default items for display are temperature
and analyzer status. When there is no run in progress, the first status line displays “Offline.” You can change
the items displayed in these lines by using the Change Status Information dialog box.

The color of the LED in the upper-right-hand corner of each button indicates the status of the analyzer as
follows:

Graen: analyzer is on but no method is running
Red: analyzer is heating {(method s running)
Yellow: analyzer is holding {method is running)
Blue: analyzer is cooling (method is running)
Dark Gray: analyzer is off

Data Analysis Q

The Data Analysis Appfication can be accessed by selecting Pyris Data Analysis either from the Pyris
Software for Windows menu in the Programs menu or from the Pyris Manager Task menu displayed by
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clicking on the Start Pyris button in the Pyris Manager panel. When you access Data Analysis either of these
ways, you have access to all data files, i.e., data from all attached analyzers. You can also access the
analyzer-specific Data Analysis application by clicking on the Data Analysis button on the toolbar while in an
Instrument Application. However, the only data files you can call up for analysis are those associated with the
current instrument.

Pyris Software for Windows lets you analyze data collected from any thermal analyzer. Data are saved to the
file that you specified in the Sample Info page in the Method Editor, to the file specified in a play list, or to the
default file name specified in Preferences. You can open multiple Data Analysis Applications from the Pyris
Manager as well as open Data Analysis windows inside an Instrument Application. You can switch from one
Data Analysis window to another by clicking on the appropriate Data Analysis button in the Pyris Manager. As
each Data Analysis window is opened, it is indicated by an additional button in the Pyris Manager bar, in
addition to the instrument buttons.

In Data Analysis, you can perform many functions on a data file to manipulate the data. The menus available
while in Data Analysis indicate the possibilities. The items in these menus can be used to rescale the displayed
curves, display different types of curves for the data, perform calculations with the data, and other functions.

Display Curves

In order to analyze your data that has been collected in a run and saved to a data file, you must first display it in
a Data Analysis window. More than one curve can be displayed in a window and more than one Data Analysis
window can be open at the same time.

Select the Data Analysis Application

After a run, click on the Data Analysis buiton on the toolbar to open Data Analysis. This Data Analysis
Application is associated with the particufar Instrument Application you are using. You can also cpen a Data
Anaiysis Application for another analyzer by selecting Data Analysis from the Pyris Manager Task menu.

Select the Data Fiie

in the Open Data File dialog box, select a data file for display. The curve is displayed as it was last
displayed before closing the file.

Use the Menus

Use the items in the View menu, Display menu, and Rescale Tools toolbar to change the display of the
data. Use items in the Curves, Math, and Calc menus to display different curves and manipulate the data,
Use the File menu items to add a curve to the display, open another window, or close the window.

]

Optimizing the Data Display Q

A curve displayed in the Instrument Viewer and the Data Analysis windows can be optimized a number of
ways, mainly by using the rescale tools on the Rescale Tools toolbar. Some of those tools are also on menus.
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Display Language

Select the language in which the LED display on the analyzer is to display its information: English, French,
German, ltalian, Japanese, or Spanish.

Ordinate Filter
The ordinate filter filters out noise from the Y signal (heat flow). Ciick on the box to allow data smoothing.
Furnace Constant

The furnace constant is calculated at the factory and is supplied on the DSC 6 Data Sheet shipped with the
instrument. Enter the value from the sheet here.

Heat Flow Conversion

The heat flow conversion (or calorimetric sensitivity) is calculated at the factory and is suppiied on the D3C
6 Data Sheet shipped with the instrument. Enter the value from the sheet here.

Environment

Cooling Device

Select the cooling device attached to your DSC 6 from the drop-down list. Available cooling devices are
circulating water or chilled gas. This parameter has no effect on the software; it is for information only.

TGA 7 Instrument Page

The TGA 7 Instrument page appears when you select the TGA 7 tab in the Preferences window. The TGA 7

Enter the default Logd Temperature which is used as the default End Condition in all methods. When the
Go To Load button omthe control panel is selected, the analyzer automatically heats or cools to the load
temperature.

Go To Temp Rate

Enter the rate at which the analyzeMNg to heat or cool in order to go to the load temperature or the user-
specified temperature entered in the control panel. Scanning rates from 0.1°C/min to 200°C/min for a

standard furnace or 0.1°C/min to 100°C/minJor high temperature furnace can be used. The exact scanning
rate used depends on the experiment you are ggrforming and the end result you are trying to achieve.

5°C/min to 50°C/min. However, you may want to
hen hold there isothermally or scan at a controlied

100 C/min to 200°C/min) are used to raise or

Most typical TGA experiments use a rate ranging §
heat or cool very rapidly to a selected temperature an

rate. In such cases, very fast heating or cooling rates (e.g
lower the sample temperature very quickly.

Y Data

Low Range
Sets the full-scale range of Y values (weight in milligrams) to 0 — 130 mg.
High Range
Sets the full-scale range of Y values (weight in milligrams) to 0 — 1300 mg.
Ordinate Filter Factor
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smoothing.

Lag Compensation
This value compensates for the lag of the analyzer in maintaining the scanning rate when heating up to the
designated temperature. It heips the analyzer get up to the designated scanning rate faster. Although the
thermal lag is small for PE power-compensated DSC analyzers (i.e., the peak shifts up by about 1.3°C as

the scan rate in increased from 5°C/min to 20°C/min), it may be significant for some applications. In cases
where temperature must be independent of scan rate, correction of measured temperature for differences
in scan rate can be performed. See Determine the Lag or Rate Compensation for an explanation on how to
determine the value to enter.

Equilibration Constant
This field is for DDSC analyzers only. Enter the number of equilibration heat — cool cycles that are to be run
at the beginning and the end of a run. It determines how long the DDSC equilibrates.

Environment

Cooling Device

Select the cooling device attached to your analyzer from the drop-down list. Available cooling devices are
Intracoolers 1 and 2 for the DSC 7, intracoolers 1P and 2P for the Pyris 1 DSC, CCA 7, water bath, ice
bath, and CryoFill for the Pyris 1 DSC. This parameter has no effect on the software; it is for information
only.

Helium Purge in Use

It you are using the Liguid Nitrogen Subambient Accessory on the DSC 7 or the CryoFill Liquid Nitrogen
Cooling System with the Pyris 1 DSC for cooling, you must use hetium for the purge gas. In this case,
select this check box. The thermoconductivity of helium is high so when you click in the Helium Purge in

Use check box the system will limit the maximum Go To Load temperature to 300°C.
Liquid Nitrogen in Use

When using the Liquid Nitrogen Subambient Accessory or the CryoFill LN2 Cooling System for cooling, select
this box.

DSC 6 instrument Page

The DSC 6 Instrument page appears when you select the DSC 6 tab in the Preferences window. The DSC6
[nstrument page is available only when in DSC 6 Instrument Application.

Analyzer Constants

Load Temperature

Enter the default Load Temperature which is used in all methods as the default End Condition. When the
Go To Load button in the control panel is selected, the analyzer automatically heats or cools to the load
temperature.

Go To Temp Rate

Enter the rate at which the analyzer is to heat or cool in order to go to the load temperature or the user-
specified temperature entered in the control panel. Proper selection of the heating rate increases the
efficiency of your analysis at the desired sensitivity. Slower heating rates improve peak resolution while
faster heating rates improve the usable sensitivity. Heating rates greater than 40°C/min are usually used for
rapidly heating or cooling the DSC 6 to the beginning temperature or the next program step or to selected
isothermal temperatures in the temperature program.

Data
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Viewing Methods and Results '@

After displaying, optimizing, and performing calculations on the data curves, you can view and printout those
results in several ways.

View Resulls

When you perform calculations, the results are not saved unless you save the data file. When a data file with
calculations is recalled, the results are not automatically displayed on the screen. Use the Results command in
the View menu to display the calcuiation results. When you select this command, the View Results dialog box
appears. All of the calculation results saved with the active curve or performed during the current session and
which can be displayed are listed. Select one or more resuits, then select the View Resuits button. The
calculations whose results cannot be displayed on the current axes are listed separately.

Use the Delete Resuits button in the View Resuits dialog box to delete calculation results from the active
curve's data file or results obtained during the current session, e.g., the Van't Hoff curve for purily. The resulis
deleted from the dialog box list will be deleted from the data file only when you save the file.

Printing Curves

Use the Print command or the Print button on the toolbar to print the active Data Analysis window. Before
printing you can use Print Setup in the File menu to set up the page(s) on which the output will be printed. The
Page Setup dialog box contains three tabbed pages in which you define a title, margins, and header and a
footer for your printout. To see what your printout will look like before printing it, select the Print Preview

command in the File menu or the Print Preview button on the toolbar.,

When you select the Print command, the Print dialog box appears. Select the printer and the number of copies
to print, or select the Properties button to display the Print Properties dialog box. In the Print Properties dialog
box, you can access a number of different print options, including whether to print in Landscape or Portrait
mode.

View Methods

You can view information about the method used to collect the data displayed in the Data Analysis window.
Make the desired data curve the active curve, then select the Method Used command in the View menu. The
View Method Properties window appears. This window comprises six pages which display the following
information:

» Sample information

» Initial conditions

¥ Equilibration parameters
¥ Method step information
» Validation Information

» Calibration information

You can change such parameters as the Sample D, Operator iD, and Comment for your data fite. The other
information is for display only; it cannot be changed.

Using the Create button on any of the pages, you can save the method as an ASCII file with the same file
name as the method but with a .TXT extension.

Print Methods
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There are two ways 1o print a method:

¢ With the Method Editor as the active window, use the Print command or the Print button on the
toolbar to print the method currently displayed in the Method Editor.

s With a Data Analysis window as the active window, select the Method Used command in the View
menu. Click on the Print button on any of the 6 pages of the View Method Properties window .

To see what your printout will look like before printing it, select the Print Preview command in the File menu or

e & on the toolbar. S AV:UV 6 MT/K}' :—-—\\

You can export your methods from Pyris Software for Windows by copying them to an ASCI! file and then
using the file in third-party software. Use the Method Used command in the Data Analysis window View menu
to perform this function. When you select this command, the View Method Properties window appears. Select
the Create button to create the ASCI text file. The file has the same file name as the method buthas a . TXT
extension. it is saved in the same directory as the method.

the Print Preview bution

Include the data peints collected in the run and/or the Calibration Information by selecting the appropriate
check box before creating the ASCIl file. The data points are saved as an ASCH table of values.

Saving Data A S@I '71\()(7" F / /e/

To save what is displayed in the Data Analysis window , select the Save bution =4 in the toclbar or Save
Data from the File menu. The derived curves currently displayed in the Data Analysis window along with the
calculation results stored with these curves and the original data and method are saved. When you open the
data file again, the data will be displayed as you saved it. Use Save Data As from the File menu to save the
data under a different file name. The original data file still exists.

If you delete a curve from the display and then save the data, the curve and ali resuits calculated on that curve
are not retrievable.

Troubleshooting

if a problem shoutd occur while using Pyris Software for Windows, first check the Release Notes that are
installed on your computer when Pyris is installed. in the Pyris Software for Windows group in the Pregrams
meny, select Pyris Readme. The text file will be displayed in Wordpad on your screen. At the end of the notes
there is information on existing known problems and workarounds. Also see the foliowing topics:

» Emergency Repair Disk

» Security

> Instrument Communication

» Long File Names
Emergency Repair Disk

The Repair Disk utility of Windows NT saves all the current system settings to an Emergency Repair Disk. You
can then use the disk to restore your computer if files become damaged. The Repair Disk should be updated
whenever there is a change in the configuration of the workstation, including adding or removing software,
printer drivers, and hardware (e.g., tape drive, sound card, multiport card, etc.). The ERD is usually created
when Windows NT is installed. You can update the repair disk by running RDISK.EXE, which is located in the
SYSTEM32 subdirectory of your Windows directory {usually \WWINDOWS\SYSTEM32 or WINNT35
\SYSTEMS32). You can also access it by going to the Windows online MHelp from the Start button menu and
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